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Concepts

Concepts

1.1 Content

Information views are created to model various slices of the data stored in an SAP HANA database.

Information views use various combinations of content data (that is, non-metadata) to model a business
use case. Content data can be classified as follows:

Attribute - Represents the descriptive data like customer ID, city, country, and so on.
Measure - Represents the quantifiable data such as revenue, quantity sold, counters, and so on.

Information views are often used for analytical use cases such as operational data mart scenarios or
multidimensional reporting on revenue, profitability, and so on.

There are three types of information views: attribute view, analytic view, and calculation view. All three
types of information views are non-materialized views. This creates agility through the rapid deployment
of changes.

Attribute View

An attribute view is used to model an entity based on the relationships between attribute data contained
in multiple source tables.

For example, customer ID is the attribute data that describes measures (that is, who purchased a
product). However, customer ID has much more depth to it when joined with other attribute data that
further describes the customer (customer address, customer relationship, customer status, customer
hierarchy, and so on).

You create an attribute view to locate the attribute data and to define the relationships between the
various tables to model how customer attribute data, for example, will be used to address business
needs.

You can model the following elements within an attribute view:
+  Simple attributes

+ Calculated attributes

+ Hierarchies

Note:
For more information about the attributes and hierarchies mentioned above, see sections 1.2 and
1.3.
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You can choose to further fine-tune the behavior of the attributes of an attribute view by setting the
properties as follows:
+ Filters to restrict values that are selected when using the attribute view.

+ Attributes can be defined as Hidden so that they can be used in processes but are not visible to end
users.

- Attributes can be defined as key attributes and used when joining multiple tables.

« The Drill Down Enabled property can be used to indicate if an attribute is available for further drill
down when consumed.

Attribute views can later be joined to tables that contain measures within the definition of an analytic
view or a calculation view to create virtual star schema on the SAP HANA data.

Analytic View
An analytic view is used to model data that includes measures.

For example, an operational data mart representing sales order history would include measures for
quantity, price, and so on.

The data foundation of an analytic view can contain multiple tables. However, measures that are selected
for inclusion in an analytic view must originate from only one of these tables (for business requirements
that include measure sourced from multiple source tables, see calculation view ).

Analytic views can be simply a combination of tables that contain both attribute data and measure data.
For example, a report requiring the following:

Customer ID Order Number Product ID Quantity Ordered Quantity Shipped

Optionally, attribute views can also be included in the analytic view definition. In this way, you can
achieve additional depth of attribute data can be achieved. The analytic view inherits the definitions of
any attribute views that are included in the definition. For example:

Customer ID/Customer Name Order Number
Product ID/Product Name/Product Hierarchy Quantity Ordered Quantity Shipped

You can model the following elements within an analytic view:

+  Simple attributes

+ Calculated attributes
* Private attributes

»  Simple measures

» Calculated measures
* Restricted easures

Note:
For more information about the attributes and measures mentioned above, see section 1.2.

* Variables

* Input parameters
Note:
For more information about the variables and input parameters mentioned above, see sections 9.8
and 9.12.
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You can choose to further fine-tune the behavior of the attributes and measures of an analytic view by
setting the properties as follows:
+ Filters to restrict values that are selected when using the analytic view.

+ Attributes can be defined as Hidden so that they are able to be used in processes but are not viewable
to end users.

+ Attributes can be defined as key attribute and used when joining multiple tables.

« The Drill Down Enabled property can be used to indicate if an attribute is available for further drill
down when consumed.

» Aggregation type on measures
* Currency and Unit of Measure parameters

Calculation View

A calculation view is used to define more advanced slices on the data in SAP HANA database. Calculation
views can be simple and mirror the functionality found in both attribute views and analytic views.
However, they are typically used when the business use case requires advanced logic that is not covered
in the previous types of information views.

For example, calculation views can have layers of calculation logic, can include measures sourced from
multiple source tables, can include advanced SQL logic, and so on. The data foundation of the calculation
view can include any combination of tables, column views, attribute views and analytic views. You can
create joins, unions, projections, and aggregation levels on the sources.

You can model the following elements within a calculation view:

+  Simple attributes
+ Calculated attributes
» Private attributes
»  Simple measures
» Calculated measures
+ Restricted measures

»  Counters
+ Hierarchies (created outside of the attribute view)
Note:

For more information about the the attributes, measures, counters, and hierarchies mentioned above,
see sections 1.2 and 1.3.

* Variables
> Input parameters
Note:

For more information about the variables and input parameters mentioned above, see sections 9.8
and 9.12.

Calculation views can include measures and be used for multi-dimensional reporting or can contain no
measures and used for list-type of reporting. Calculation views can either be created using a graphical
editor or using a SQL editor. These various options provide maximum flexibility for the most complex
and comprehensive business requirements.
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1.2 Attributes and NMeasures

Attributes
Attributes are individual non-measurable analytical elements.

Simple Attributes

Simple attributes are individual non-measurable analytical elements that are derived from the data
foundation.

For example, PRODUCT_ID and PRODUCT_NAME are attributes of a PRODUCT subject area.
Calculated Attributes

Calculated attributes are derived from one or more existing attributes or constants.

For example, deriving the full name of a customer (first and last name), assigning a constant value
to an attribute that can be used for arithmetic calculations.

Private Attributes

Private attributes used in an analytic view allow you to customize the behavior of an attribute for
only that view.

For example, if an analytic view or a calculation view include an attribute view, it inherits the behavior
of the attributes from the attribute view (set the parameter once and it is replicated in all views
consuming it).

By contrast, if you create an analytic view for one specific use case in which you want a particular
attribute to behave differently than it does in the attribute view to which it belongs, you can define it
as a private attribute.

Measures

Measures are simple measurable analytical elements. Measures are derived from analytic and calculation
views.

Simple Measures

A simple measure is a measurable analytical element that is derived from the data foundation.
For example, PROFIT.

Calculated Measure

Calculated measures are defined based on a combination of data from OLAP cubes, arithmetic
operators, constants, and functions.

For example, calculated measures can be used to calculate the total sales of a product across five
regions, or to assign a constant value to a measure for a calculation.
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* Restricted Measure

Restricted measures are used to filter the value based on the user-defined rules for the attribute
values.

+ Counters

Counters add a new measure to the calculation view definition to count the recurrence of an attribute.
For example, to count how many times Product appears.

Note:
You can choose to hide the attributes and measures that are not required for client consumption.

For example, for a complex calculation that is derived from a series of computations, you can hide the
levels of computations that are not required for reporting purposes.

1.3 Hierarchies

Hierarchies are used to structure and define the relationship between attributes of attribute views and
calculation views that are used for business analysis. Exposed models that consist of attributes in
hierarchies simplify the generation of reports.

For example, consider the TIME attribute view with YEAR, QUARTER, and MONTH attributes. You
can use these YEAR, QUARTER, and MONTH attributes to define a hierarchy for the TIME attribute
view as follows:
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Year

Quarter 1 Quarter 2 Quarter 3 Quarter4

Jan Feb | | Mar Jul Aug || Sep

Apr May Jun Oct MNowv Dec

The following types of hierarchies are supported:
* Level Hierarchy

Level Hierarchies are hierarchies that are rigid in nature, where the root and the child nodes can be
accessed only in the defined order. For example, organizational sturctures, and so on.

» Parent/Child Hierarchy

Value hierarchies are hierarchies that are very similar to BOM (parent and child) and Employee
Master (Employee and Manager). The hierarchy can be explored based on a selected parent, and
there are cases where the child can be a parent. This hierarchy is derived based on the value.

1.4 Users and Roles

Users and roles are assigned to create and modify content in the modeler perspective. For more
information, refer to http://help.sap.com/hana -> SAP HANA Administration and Security-> see section
SAP HANA Users, Roles, and Authorizations.

There are two types of users with roles specific to modeling activities:
- SAP_TEMPLATE_MODELING

This is used as a template role that can be used to create users to work on content.
+ SAP_TEMPLATE_CONTENT_ADMIN

This is used as a template role for users who are responsible for managing repository content at a
higher level, and for managing teams who develop and test the content.
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Users with this role are able to:
* Maintain delivery units
» Export and import content

* Create, update, and delete active native and imported packages and objects in these packages.
They can also grant all these privileges to other users.
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Overview of Modeling Data

SAP HANA modeler is a graphical data modeling tool which allows you to design analytical models and
later analytical privileges, that governs the access to those models.

The figure below shows the process flow for modeling within SAP HANA.

Modeling Process Workflow

Import
Source I(:rfeate "
System ot ion
metadata OLMEES
B > = Views
Physical tables are created
are created Attribute Vi
dynamically (1:1 =Alinbute Views
schema definition =Analytic Views
of source system =Calculation
tables) Views
Provision
Data
* Physical tables
are loaded with
content.
Prerequisites

Consume

= Consume with
choice of client
tools

*BICS, MDX

Deploy

» Column views are
created and
activated

* You have installed all SAP HANA components that are necessary to enable data replication. For
information about installing SAP HANA, see SAP HANA Installation Guide.

»  The modeler perspective is part of the SAP HANA studio and will be installed together with the SAP
HANA studio, as described in SAP HANA Database - Studio Installation and Update Guide.

* You have configured all SAP HANA components that are necessary to enable data replication. For
more information see the Configuring Data Replication section in SAP HANA Master Guide.

Procedure

The tasks that you can perform in the modeler are grouped as follows:

1. Importing the Netadata

You need to import the table definitions in the modeler perspective. For more information, see Importing

Metadata.
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Overview of Modeling Data

2. Provisioning Data

You need to load data into the table definitions in the modeler perspective. More information: Loading
Data into Table Definitions.

Note:
You can use the features offered by the modeler only if, the modeler version is compatible with the

appropriate server version.
3. Creating Content Ohjects

You need to create content objects in the modeler perspective. More information: Creating Content
Objects.

4. Processing Content Objects

For more information about the tasks that you can perform after creation of content objects, see
Processing Content Objects.
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Adding a System

You use this procedure to add a system in which you want to create your content objects for analytical

purposes.
Procedure
1. From the desktop, choose Start > Studio.
2. Choose Window > Open Perspective > Other.
3. Choose Modeler.
4. Choose OK.
5. Navigate to the Navigator pane.
6. From the context menu, choose Add System.
7. Enter the host name, instance number, and a description for the system you want to add.
8. Choose Next.
9. Select the required options.
10. Choose Finish.

Result
If you add multiple systems, then:

*You can define a specific system as a default system by choosing Window > Preferences > Modeler
> Quick Launch.

* You can to switch to a different system by choosing Select System in the Quick Launch page.
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Importing Metadata

4.1 Configuring Data Services for Metadata Import

You use this procedure to enable the SAP HANA modeler for importing of metadata.

Procedure

1.

akrobd

N

Set the Passphrase

Log on to the Central Management Console of SAP BusinessObjects Enterprise (BOE).
Choose Manage > Applications.

Choose Data Services Application.

Choose Settings.

In the Encryption Passphrase field, enter the passphrase that you have been using for the SAP
In_Memory Computing studio.

Choose Save.
Restart the TOMCAT and BOE services.

. Disahle Session Security

Log on to the Data Services Management Console.

Choose Administrator.

In the navigator pane, choose Web Services.

Choose the Web Services Configuration tab page.

Select the Import_Repo_Object checkbox to save the connection details.
Select Disable Session Security from the dropdown menu.

Choose Apply.

. Creating a Data Source

Go to Start > Control panel > Administrative Tools.
Choose Data Sources (ODBC).

Choose the System DSN tab page.

Choose Add.

Select HDBODBC from the driver list.

Choose Finish.

Enter a name and description for the data source.
Enter server details.
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Note:

The format in which you need to enter details is <host>:3<instance number>15. For example,
vml2562.wdf.sap.corp:34715.

9. Enter the required database details.
Note:

The format in which you need to enter the database details is <SID><instance number>. For example,
M4747.

10. Choose Connect.

4.2 Creating Schemas

You use this procedure to create schemas where you import table definitions.

Procedure

1. From the Quick Launch tab page, choose SQL Editor.
2. In the SQL editor, write the script, create schema <schema name>.
3. Execute the script.

Resuit
System creates the schema, and places it under the Catalog node.

4.3 Importing Table Definitions

You use this procedure to import table definitions (metadata) from a required source system. You use
these table definitions for creating various content models such as attribute, analytic, and calculation
views.

Based on your requirement, you use one of the following approaches:

+ Mass Import: To import all table definitions from a source system. For example, you use this approach
if this is a first import from the given source system.

+ Selective Import: To import only selected table definitions from a source system. For example, you
use this approach if there are only few table definitions added or modified in the source system after
your last import.

Prerequisites
You have configured the SAP HANA modeler for importing metadata using Data Services infrastructure.

For more information, see Configuring Data Services for Metadata Import.
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Procedure
Importing All Table Definitions

9.

NG RWON=

In the File menu, choose Import.

Expand the SAP HANA Content node.

Choose Mass Import of Metadata.

Choose Next.

Select the target system where you want to import all the metadata.

Choose Next.

In the Connection Details dialog, enter the OS User and Password of the target system.
Select the required source system.

Note:
If the required system in not available in the dropdown list, you need to contact your administrator.

Choose Finish.

Importing Selected Table Definitions

©

1.
12.
13.
14.

NoapwN-=

From the File menu, choose Import.

Expand the SAP HANA Content node.

Choose Selective Import of Metadata.

Choose Next.

Select the target system where you want to import the metadata.
Choose Next.

Select the required source system.

Note:
If the required system in not available in the dropdown list, you need to add the new source system.
For more information, Adding Connections.

In the Type of Objects to Import field, select the required type.

. Choose Next.
. Add the required objects (tables or extractors) that you want to import.

Note:
If you want to add dependent tables of a selected table, select the required table in the Target pane
and choose Add Dependent Tables from the context menu.

Select the schema where you want to import the metadata.
If the object type is extractor, select the package.

Choose Next.

Choose Finish.

If source object is a table or non V-type extractor, system creates physical tables and stores them in
the selected schema. If source object is a V-Type extractor, system creates content models and stores
these models in the selected package, and the underlying physical tables in the schema.
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4.4 Adding Connections

Procedure
Choose Manage Connections.

Enter the Application Server details.
Enter the username and password.
Enter the passphrase.

Enter the Client and System Number.
To test the connection, choose Test.
Save the connection details.

Choose Close.

WeNOO RN

Enter a name and description for the connection.

20
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Loading Data into Table Definitions

You use this procedure to load data into your table definitions. Depending on your requirement, you
can perform:

+ Initial Load - to load all data from a source SAP ERP system into the SAP HANA database by using
Load Controller or SAP Landscape Transformation (SLT). This is mostly applicable when you are
loading data from the source for the first time.

- Data Replication - to keep the data of selected tables in the SAP HANA database up-to date with
the source system tables by using SyBase Replication Server or SAP Landscape Transformation
(SLT).

For more information on replication technologies, see SAP HANA Replication Technologies section in
SAP HANA 1.0 Master Guide.

Prerequisites

» If you are using the Load Controller or Sybase Replication Server infrastructure, make sure that you
have imported all table definitions into the SAP HANA database. For more information, see Importing
Metadata.

+ If you are using the SLT component, the source system(s), target system and the target schema,
are configured by the administrator during the installation.

Procedure

1. From the Quick Launch page, choose Data Provisioning.

2. If you are using SLT-based replication, choose Source.

3. Choose Load (for initial load) or Replicate (for data replication) as appropriate.

4. Select the required tables.

5. Choose Add.

6. If you are using the load controller infrastructure, choose Next and enter the operating system user

name and password.
7. Choose Finish.

5.1 Suspending Data Load

You use this procedure to stop data replication for the selected tables temporarily if you are using
SLT-based replication.
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Procedure
1. On the Quick Launch tab page, choose Data Provisioning.
2. Choose Source.
3. Choose Suspend.
4. Select the tables for which data replication is to be suspended in any of the following ways:
» Search for the required tables.
a. Select the table from the object list.
b. Choose Add.

c. Ifyouwant to save the list of tables selected for suspension locally for future reference, perform
the following steps:

a. Check Save selected tables checkbox.
b. Specify the target location.

+ Load the list of tables from a local file as follows:
a. Choose Load from file.
b. Select the required file.

Note:
The file should be of type csv.

5. Choose Finish.

5.2 Resuming Data Load

You use this procedure to resume data replication for the suspended tables, if you are using SLT-based
replication.

Procedure
1. On the Quick Launch tab page, choose Data Provisioning.
. Choose Source.
. Choose Resume.
. Select the tables for which data replication is to be resumed in any of the following ways:
» Search for the required tables.
a. Select the table from the object list.
b. Choose Add.
c. If you want to save the list of selected tables for future reference, perform the following steps:
a. Check Save selected tables checkbox.
b. Specify the target location.

A WODN

* Load the list of tables from a local file as follows:
a. Choose Load from file.
b. Select the required file.
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5.

Note:
The file should be of type csv.

Choose Finish.

5.3 Uploading Data from Flat Files

You use this procedure to upload data from flat files, available in a client file system to SAP HANA
database. If the table schema corresponding to the file to be uploaded already exists in the SAP HANA
database, the new data records are appended to the existing table. If the required table for loading the
data does not exist in the SAP HANA database, create a table structure based on the flat file. The
application suggests the column names and data types for the new tables and allows you to edit them.
The new table always has a 1:1 mapping between the file and table columns. The application does not
allow you to overwrite any columns or change the data type of existing data. The supported file types
are .csv, .xls, and .xIsx.

Procedure

1.

o

9.

In the File menu, choose Import.

2. In the Select an import source section, expand the SAP HANA content node.
3.
4. In the Target System section, select the target system where you want to import the data using the

Select Import Flat File, and choose Next.

flat file, and choose Next.
On the Flat File Upload screen, browse for the file containing the data you want to upload.
If you have selected a CSV file, select a delimiter.

Note:
A delimiter is used to determine columns and pick the correct data from them. In a csv file, the
accepted delimiters are ',', ';' and "".

If you have selected an .xls or .xlsx file, select a worksheet.

If you want to load the data into a new table, select the New option and perform the following
substeps:

a. Choose Next.

b. Onthe Manage Table Definition and Data Mapping screen, map the source and target columns.

Note:

»  Only 1:1 column mapping is supported. You can also edit the table definition by changing the
data types, renaming columns, adding or deleting the columns, and so on.

* You can choose to map the source and target columns using the Auto Map option. If you
choose the one to one option then first column of the source is mapped with the first column
at the target. If you choose the option Map by name, the source and target columns with same
name are mapped.

If you want to append the data to an existing table, select the Existing option and perform the
following substeps:

23
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a. Choose Next.
b. Onthe Manage Table Definition and Data Mapping screen, map the source and target columns.

10. Choose Finish.
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Copying Contents Delivered hy SAP

You use this procedure to copy the objects available in a package to other packages in the same system
based on your business use case.

You use this functionality in one of the most common scenarios, that is, to copy the standard content
shipped by SAP or an SAP partner to your local package to meet your modeling and reporting use
cases. For example, from <sap.ecc.fin> to <customer.ecc.fin>.

To copy the objects, you need to map the source root packages to the target root packages. You need
to activate the copied objects in the target package to consume them for reporting purposes.

Note:
+ We recommended that you copy the content shipped by SAP or an SAP partner to your local package
to avoid overwriting your changes during the next import.

+ If you copy an object but not its dependent objects (if any), the copied object in the target package
will have references to the dependent objects in the source package.

» For script-based calculation views and procedures, even if you copy the dependent objects, you
need to change the script manually and adjust the dependent object references.

Prerequisite
You have the following privileges:

+  REPO.READ for the source package.
* REPO.MAINTAIN_NATIVE_PACKAGES and REPO.EDIT_NATIVE_OBJECTS for the root package.

Procedure

1. From the Quick Launch tab page, choose Mass Copy.

2. To create a mapping between the source package and the target package, perform the following
substeps:

a. Choose Add.
b. Select a source package and a target package.

Note:
If you want to create more package mapping, select the source and target packages as required.
c. Choose Next.

3. Select the required objects, and choose Add.
4. Choose Next to view the summary.

Note:
You can deselect an object to avoid copying it to the target package.
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5. Choose Finish.

26 2012-05-09



Mapping the Authoring Schema to Physical Schema at the Target

Mapping the Authoring Schema to Physical Schema at
the Target

You use this procedure to map the authoring schemas to the physical database schemas in the target
system to access and deploy the transported objects.

A physical schema is the schema where the tables are available. It may differ in the source and target
systems.

An authoring schema (logical schema) is the physical database schema in the source system with
which the content objects are created.

Schema mapping is done when the physical schema in the target system is not the same as the physical
schema in the source system.

Content object definitions are stored in the repository, and contain references to the physical database
schemas. When you copy the content objects to a different system, for example, from an SAP system
to a customer system, or between customer systems, the object definition still refers to the physical
database schemas at the source. To resolve this, you use schema mapping.

Note:
You need to map the references of script-based calculation views and procedures manually, that is, by
changing the script.

You can map several authoring schemas to the same physical schema. For example, content objects
delivered by SAP refer to different authoring schemas, whereas in the customer system, all these
authoring schemas are mapped to a single physical schema where the tables are replicated.
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Example:
SAP (Hana System) Customer (Hana System)
Repository Repository
Rpat/AvT npat/av:
ERAVT HRANT

SAP_HAT TH1 SAP_HAT TH1
SAP_ERP MARA

hpatiav2 hpallAv:
SAP HAZ TH2 SAP HAZ TH2

I I |
e | S
EMEA
HA
HA

SAP_ERP MARA

<empty>

Catalog Catalog
Schema Schema || Schema Schema Schema
SAP_ERP SAP_HA1 || SAP_HAZ EMEA HA

Schema
SAP_CRM|

_ = _,@ @ @, _,@

Consider a source system, SAP, with an information object, AV1. This refers to the table MARA in the
SAP_ERP physical database schema. There is a target system, Customer, with the physical database
schema EMEA.

After you import content, the object AV1 cannot be activated in the Customer system, since it still
refers to SAP_ERP schema.

AV1 in the Customer system currently refers to SAP_ERP. To be able to activate the object, you need
to modify the mapping of AV1 in the Customer system. To do this, a mapping is created in the target
system Customer between the authoring and physical schema as follows:

Authoring Schema Physical Schema

SAP_ERP EMEA

Procedure

On the Quick Launch tab page, choose Schema Mapping.
Choose Add.

Enter the authoring schema name.

Select the physical schema.

Choose OK.

aprwbd-=
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Setting Preferences for Nodeler

You use this procedure to set up the default settings that the system uses whenever you log on.

Procedure

1. From the Quick Launch tab page, choose Manage Preferences.
2. Expand the Modeler node.

3. ldentify the required preference and perform the corresponding substeps from the table below:
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Requirement Preference ‘ Substeps

To specify the structure of content pack-
ages in Navigator pane

Content
Presenta-
tion

a. If you want to view the package struc-
ture in a hierarchical manner such that,
the child folder inside the parent folder,
select Hierarchical.

b. If you want to view all the packages at
the same level like, sap, sap.ecc,
sap.ecc.ui, choose Flat.

c. If you want to group together similar
objects in a package like attribute views
in Attribute View package, select Show
Object Type Folders.

d. Choose Apply.

e. Choose OK.

To set the preferences for loading data
using flat file

Flat File

a. Browse the location to save error log
files for data load using flat files.

b. Enter the batch size for loading data.
For example, if you specify 2000 and
a file has records of 10000 rows the
data load will happen in 5 batches.

c. Enter a decision maker count that will
be used to propose data types based
on the file. For example, enter 200 if
you want the proposal to be made
based on the 200 rows of file data.

To set the default value for the client that
will be used while previewing model data.

Default
Model Pa-
rameters

Select the client from the Default Client
drop-down list.

To enforce various rules on objects

Note:
Enforcing validation rules with severity as
“Error” are mandatory.

Validation
Rules

a. Select the required rules to be applied
while performing object validation.

b. Choose Apply.

c. Choose OK.

To determine the numbers of rows to be
displayed in a page

Data Pre-
view

a. Select the maximum rows for data pre-
view as required.

b. Choose Apply.
c. Choose OK.
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Requirement Preference ‘ Substeps

To specify location for job log files Logs a. Expand the Logs node.

b. Select Job Log.

c. Browse the location where you want to
save the job log files.

d. Choose Apply.

Choose OK.

o

To enable logging the repository calls and | Logs
specify location for repository log files

Expand the Logs node.

Select Job Log.

Select true from the drop-down list.
Browse the location where you want to
save the repository log files.

Choose Apply.

f. Choose OK.

a0 oo

o

To enable search for the attributes used |Search Op- |, select Enable Search Attributes.
in the views tions

T

Choose Apply.
c. Choose OK.

4. To establish a connection with the server from where you need to import data, perform the following
substeps:

®Qoo0oT®

=h

= 000Dy

In the Quick Launch tab page, choose Configure Import Server.
Enter the IP address of the server from which you want to import data.
Enter the repository name.

Enter the ODBC data source.

Choose OK.

you want to generate time data, then perform the following substeps:

In the Quick Launch tab page, choose Generate Time Data.

In the Calendar Type field, select the required option.

Enter the period for which you want to generate data.

If the calendar type is Fiscal, select a variant table, and a fiscal variant.
If the calendar type is Gregorian, select the granularity for the data.
Choose Generate.

System populates the generated time data in M_TIME_DIMENSION_MONTH,
M_TIME_DIMENSION_WEEK, M_TIME_DIMENSION, and M_FISCAL_CALENDAR tables present
in the _SYS_BI schema.

6. To set vendor for the content you are developing, perform the following substeps:

a.
b.
c.
d.

Choose Window > Open Perspective > Administration Console.
In the Navigator toolbar, choose Administration.

Choose Configuration tab page.

Expand indexserver.ini node.
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Expand repository node.

Select content_vendor.

From the context menu, choose Change.
Enter a value.

Note:
Itis recommended to use reserved DNS names for vendor, to avoid naming conflicts. For example,
SAP content development systems should use the vendor sap.com.

SQ o
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Creating Content Objects

You use this procedure to create the appropriate structural objects that are required to create and deploy
the content. In addition to creating the information views, you create additional objects such as packages
(for organizing content), procedures (for SQL routines you may want to call repeatedly), and analytic
privileges (for applying restrictions on which data users can see), as appropriate.

Note:
You can find the different types of content objects in the table below:
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Content Ohject

Type
Package

Description

Groups together related content objects in SAP HANA studio.

Procedure

SQL procedures that can be reused by other content objects.

Analytic Privilege

Allows selective access control for the database views that are generated when
modeled views (analytic views, calculation views, attribute views) are activated.

Attribute View

Defines joins between tables and selects a subset (or all) of their columns. The
rows selected can also be restricted by filters. An additional application of attribute
views is as dimensions in the star schema defined by an analytic view. In this use
case, the attribute view adds more columns and also hierarchies as further anal-
ysis criteria to the analytic view. In the star schema of the analytic view the attribute
view is shown as a single dimension table (although it might join multiple tables),
that can be joined to a fact table. For example, attribute views can be used to join
employees to organizational units and then the result can be joined to a sales
fact table in the analytic view.

Analytic View

Retrieves data from single or joined database tables. Analytic views can contain
two types of attributes (or columns): measures and normal attributes. All measures
must reside in a single table (the fact table) and must be aggregated when queried.
Normal attributes can be handled as regular columns and do not need to be ag-
gregated. Attributes can either be picked from the underlying tables, or are added
to the analytic view by joining attribute views (also known as dimensions).

Calculation View

Provides a composite of other views or tables. Inside the calculation view, these
are referred to as data sources. The calculation view offers the nodes/operations:
join, union, projection and aggregation. These operations work on Data Sources
and/or on top of other operations. The calculation view can be defined graphically,
by building a tree of operations, or by writing SQL script in a text-based editor.

Procedure

1. Create a Package
More information: Creating a Package

2. Create an Attribute View

More information: Creating an Attribute View

3. Create an Analytic View
More information: Creating an Analytic View

4. Create a Calculation View

More information: Creating a Calculation View

5. Create a Procedure
More information: Creating a Procedure
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6. Create an Analytic Privilege

More information: Creating an Analytic Privilege

Note:

To create, read, edit, delete, activate, or maintain an information object or package, you must have
repository authorization at package level.

To add a description for a model and its elements in the chosen language, specify the model language
when logging on to the system.

Allimported objects open in read-only mode. You can choose to edit an imported object by selecting
the Edit Imported Object option available in Switch Version on the editor toolbar. The changes
made to the imported object are overriden if you import the same object again.

If the logon locale is different from the original language of an object that is to be edited, the object
opens with a warning, and you must maintain all the texts in the original language.

9.1 Creating a Package

You use this procedure to create packages to group related objects together in a structured way.

You can create either a structural package or a non-structural package. The two types of packages are
described in the table below:

Structural A structural package helps to organize the content in a logical package tree. It

categorizes objects using the subpackages. This ensures that each object is as-
sociated with a particular package.

Non Structural A non structural package contains subpackages and content objects.
Procedure
1. On the Quick Launch page, choose Package.
2. Enter a name and description for the package.
Note:
Packages that use a dot in their name form a logical hierarchy. For example, "a.b" is considered to
be a subpackage of "a" and "a.b.c" is considered to be a subpackage of "a.b".
3. If you want to specify the entity with which a package and it's objects are exported to a server, select
the delivery unit from the drop-down list.
Note:
The assignment of packages to delivery units is completely independent of the package hierarchy.
4. From the Original Language drop-down list, select the same language for the package as your
logon language.
5. If you know the user responsible for maintaining the content in the package, select the user from

the Person Responsible dropdown list.
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If the object is relevant for translation, choose Translation.

. Select the required terminology domain to determine the correct terminology of the text that needs

translation.

. Enter a Text Collection to associate a package with a collection in order to specify the language

into which the package objects are to be translated.

. To provide a suggestion regarding the translation of the package, enter text in Hint.
10.
1.
12.

Enter a text status.

Choose OK.

To specify the package type, perform the following substeps:

a. Inthe Navigator pane, select the package.

b. In the Properties pane toolbar, choose Edit Package Details.
c. From the Structural drop-down list, choose the required option.
d. Choose OK.

Note:

The package system-local and all of its subpackages are not transportable. All other packages are
transportable. You can view the package property Transportability to check whether or not the
package can be transported.

All sub-packages of system-local.generated should be used for generated content (content that is
not created by manual user interaction). You can view the package property Content type to check
whether the package contains generated or edited content.

9.2 Creating an Attribute View

You use this procedure to create a view that is used to model descriptive attribute data (that does not
contain measures) using attributes. For more information regarding attribute view, see section Content.

Note:
You need this view for creating a multidimensional view.

Prerequisites

You have imported TO09 and TO09B tables for creating a fiscal time attribute view.

Procedure
1. Set Parameters

1.

aprobd

In the Modeler perspective, expand the Content node of the required system.
Select the package where you want to save your information object.

From the context menu, choose New > Attribute View.

Enter a name and description for the view.

To create data foundation for the view, perform substeps of the required scenario given in the table
below:

36

2012-05-09



Creating Content Objects

Scenario Substeps

Create a view with table attributes. a. Choose Standard.

b. Choose Next.
c. Add the required tables to the Selected list.

Create a view with time characteristics. a. Choose Time.

b. In the Calendar Type field, select the required
option.
« Ifthe calendar type is Fiscal, select a variant
table, and a fiscal variant.
« Ifthe calendar type is Gregorian, select the
granularity for the data.

c. To select a table for defining the view’s output
structure, perform one of the following substeps:

«  Touse the default table, select Auto Create.

+ To specify tables, choose Next and select
the required tables.

Note:

The tables used for attribute creation are
M_TIME_DIMENSION, M_TIME_DIMEN-
SION_MONTH, M_TIME_DIMENSION_WEEK and
M_FISCAL_CALENDAR. If you want to do a data
preview on the created attribute view, you need to
genenate time data into the mentioned tables from
the Quick launch tab page.

Derive a view from an existing view —inthis |5 Choose Derived.

case, you cannot modify the derived view. b. Select the required attribute view.

Copy a view from an existing view — in this a. Choose Copy From.

case, you can modify the copied view. b. 2. Select the required attribute view.

6. Choose Finish.

2. Define Output Structure

1. Select the required table field, and perform substeps of the required scenario given in the table
below:
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2,

&

NoapwwN-=

8.

Scenario Substeps

Include table field in the output structure.

From the context menu, choose Add as At-
tribute.

Include table field in the output structure as a key
element.

From the context menu, choose Add as Key
Attribute.

Include table field in the output structure and
specify a filter condition based on which system
must display data for this field in the output.

a. From the context menu, choose Apply Filter.
b. Select the required operator and enter the
values.

a.

If you want to query data from more than one table, perform the following substeps:
In the editor pane, from the context menu, choose Create Join.

b. Select the required tables, columns, join type, and cardinality.

c. Choose Create Join.

Note:

*  You can choose to add the same table again in Data Foundation pane using table aliases in
the editor. For example, in cases where you want to create self join or to have different cardinalities

from the same table.

* You can choose to create a hierarchy between attributes of the view. For more information, see

Creating a Hierarchy.

. (Optional) Create Calculated Attributes

From the context menu, choose New.
Choose the Key tab page.

Select a data type for the calculated attribute.
Enter the length and scale.

Note:

In the output pane, right-click Calculated Attributes.

Enter a name and description for the calculated attribute.

Define the attribute using the required attributes, operator, and function.

For more information about functions, see Functions used in Expressions.

Choose OK.

Note:
You can specify a value for the Default Client property of the view to filter the table data that is relevant
to a specific client as specified in the table fields, such as, MANDT or CLIENT, at runtime. The default
value for the property is the one that is specified as preferences. If the property is set to Dynamic then
at runtime, the value set for the Session Client property is considered to filter table data. The Session
Client property is set while creating a user. For more information about how to set the default value for

Default Client, see Setting Preferences for Modeler.

4. Activate the View

1

. Choose File > Save.

2. From the context menu of the view, select one of the following options as appropriate:
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» Activate — to activate the current view only
- Cascade Activate - to activate the current view and its dependent objects

Note:
For more information about activation, see Activating Objects.

Result

You can find the activated model in the related package. If you want to modify this model, from the
context menu, choose Open and make the necessary changes.

If you want to view the creation job details, refer to the details on the Job Log tab page.

9.3 Creating an Analytic View

You use this procedure to define a multidimensional view (OLAP cube) based on database tables,
attribute views and facts of a specific table.

Procedure
1. Set Parameters

1.

Al

In the Modeler perspective, expand the Content node of the required system.
Select the package where you want to save your information object.

From the context menu choose, New > Analytic View.

Enter a name and description for the view.

To create data foundation for the view, perform substeps of the required scenario given in the table
below:
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Scenario Substeps

Create a new analytic view.

a.
b.

. Add the required tables and attribute views to the Selected

Choose Create New.

If you want to perform currency conversion for measures,
select the required schema from the Schema for Conver-
sion.

Choose Next.

list.
Choose Finish.

Create an analytic view from an ex-
isting analytic view.

. Choose Finish.

Choose Copy From.

If you want to perform currency conversion for measures,
select the required schema from the Schema for Conver-
sion.

Select the required analytic view.

2. Add Attributes and NMeasures

1. Select the required table field, and perform substeps of the required scenario given in the table

below:

Scenario Substeps

Include table field in the output structure. From the context menu, choose Add as At-

tribute.

Add measures based on which you want to view | From the context menu, choose Add as Mea-
data from the fact table for analysis purposes. |[sure.

Include table field in the output structure and |5 From the context menu, choose Apply Filter.
specify a filter condition based on which system b

must display data for this field in the output.

. Select the required operator and enter the
values.

quired for client consumption.
Note:

an analytic view.

You can choose to hide only private attributes of

b. In the properties pane, assign value True to
the Hidden property.

3. Create Joins

1. If you want to define relationship between tables to query data from two or more tables, perform the

following substeps:

a. In the editor pane, from the context menu, choose Create Join.
b. Select the required tables, columns, join type, and cardinality.
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10.
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c. Choose Create Join.

. (Optional) Create Calculated Attributes

In the output pane, right-click Calculated Attributes.

From the context menu, choose New.

Enter a name and description for the calculated attribute.

Choose the Key tab page.

Select the data type for the calculated attribute.

Enter the length and scale.

Define the attribute using the required attributes, operator, and function.

Note:
For more information about functions, see Functions used in Expressions.

Choose OK.

. (Optional) Create Calculated Measures

In the Output pane, right-click Calculated Measures.

From the context menu, choose New.

Enter a name and description for the calculated measure.

Select the required Aggregation Type.

If you want to hide the measure while previewing data, select Hidden.
Select the required data type for the calculated measure.

Enter the length and scale.

Define the measure by selecting the required measures, operator, and function.

Note:
For more information about functions, see Functions used in Expressions.

. Choose Validate.

Note:

If you want to associate the calculated measure with a unit of currency or weight, choose the
Currency/Unit of Measure tab page. For more information, see Using Currency and Unit of Measure.

Choose OK.

. (Optional) Create Restricted NMeasures

In the Output pane, select Restricted Measures.

From the context menu, choose New.

Enter a name and description for the restricted measure.
Select the required aggregation type.

Choose the measure from the drop-down list.

To add a restriction, choose Add Restriction.

Select the required parameter, operator, and value.
Choose OK.
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Note:

You can choose to create variables, and bind them to attributes for filtering data. The values you
provide to the variables at the runtime determines which data records are selected for consumption.
For more information, see Assigning Variables.

You can create input parameters for the analytic view that works as placeholder in the query. For
more information, see Creating an Input Parameter.

You can specify a value for the Default Client property of the view to filter the table data that is
relevant to a specific client as specified in the table fields, such as, MANDT or CLIENT, at runtime.
The default value for the property is the one that is specified as preferences. If the property is set
to Dynamic then at runtime, the value set for the Session Client property is considered to filter
table data. The Session Client property is set while creating a user. For more information about
how to set the default value for Default Client, see Setting Preferences for Modeler.

7. Activate the View

1.
2,

Choose File > Save .

From the context menu of the view, select one of the following options as appropriate:
» Activate — to activate the current view only.

- Cascade Activate - to activate the current view and its dependent objects.

Note:
For more information regarding activation, see Activating Objects.

Result

You can find the activated model in the related package. If you want to modify this model, from the
context menu, choose Open and make the necessary changes.

If you want to view the creation job details, refer to the details on the Job Log tab page.

9.4 Creating a Calculation View

You create a calculation view when your business use case demands complex business logic. For
queries that involve more than one analytic view or table, you use a calculation view. You can use
calculation views to derive values and Key Performance Indicators(KPIs).

Procedure

il

In the Modeler perspective, expand the system node from the Navigator pane.
Expand the Content node.

Right-click the required package.

From the context menu, choose New > Calculation View.

a. Enter a name and description.

b. Select the required package.
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Create a Script-Based Calculation View

1.
2.

7.

Choose SQL Script.
Select the required schema from the Default Schema drop-down list, for unqualified access in SQL.
Note:

If you do not select a default schema, while scripting, you need to provide fully qualified names of
the objects used.

. Select the required option from the Run With drop-down list.

Note:

Definer's right. If you want to control the access to the model for other users.
Invoker's right. If you want system to grant access to the model for other users.

Choose Finish.

. Define the Output Structure

a. Choose Define Output Parameter from the output pane.

b. To add the output parameters with the required data type and length, from the Output pane
toolbar, choose Define Output Parameter button.

Note:
The order and data types of the output parameters should match the table columns order and
data type which is used in the select query

c. Choose OK.

. Define the Function

a. Define the function using SQL Script commands.

Note:

«  For more information about the syntax and examples of SQL functions, see SQL Functions
on Content Assist.

* You can create variables, and bind them to attributes for filtering data. The values you provide
to the variables at the runtime determines which data records are selected for consumption
. For more information, see Assigning Variables.

* You can create input parameters for the calculation view that works as placeholder in the
query. For more information, see Creating an Input Parameter.

* You can create hierarchy between attributes of the view. For more information, see Creating
a Hierarchy.

Save and Activate
a. To save the view, choose File > Save.

b. From the context menu of the calculation view, choose Activate.

Note:
For more information about activation, see Activating Objects.
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Create a Graphical Calculation View

1. Choose Graphical.

2. Select the required schema from the Schema for Conversion drop-down list.

Note:

The schema selected for conversion is used during the currency conversion. It list down all the
schemas which has currency related tables and the same can be changed during design time from

the properties.
3. Choose Next.

4. Follow the instructions on the wizard to select the required tables and content models.

Adding Unions/Joins/ Projections/ Aggregation

a. From the Tools Palette, choose the required option as follows:

View

Union

Used to combine the result set of two or more data sources. For example,

Description

to know the names of all the employees of a store with different branches
maintaining their own employee records table.

Join

Used to query data from two or more data sources, based on some condition.
For example, to retrieve the sales of two stores maintaining individual table
for sales based on the customer id.

Projection

Used to filter or create a subset of the required columns of a table or view
for creating the model. For example, selecting the employee name and sales
quantity from a table consisiting of many more columns.

Aggregation

Used to summarize data of a group of rows by calculating values in a column.
For example, to retrieve total sales of some product in a month. The support-
ed aggregation types are sum, min, and max.

Note:

» The input for union, join, projection, and aggregation views can consist of data sources, union,
join, projection or aggregation views.

* You can have only one source of input for aggregation and projection view.

* You can choose to create filters on projection and aggregation view attributes.

b. Map the input to the selected option.

Mapping attributes

a. To map attributes in a union view, drag and drop the required columns from Source to Target.

You can also modify the attribute mapping. More information: Managing Attribute Mappings

To create a system generated mapping, choose Auto Map By Name.
b. In case of a join view, join the columns of the source data sources.

Note:

»  The output of a union view is the attributes that you add to the target.

+ The output of a join view is the joined columns. However, to add additional attributes to the
view's output, from the context menu, choose Add to Output.
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«  To add attributes of projection or aggregation view to it's output, choose Add to Output from
the context menu.

Creating Calculated Columns (optional)

The output of union, join or projection view is stored as a column in the output pane.To perform
calculations on these columns, perform the following steps:

1. Right-click the Calculated Columns node.
2. From the context menu, choose New.

a.

b
c.
d

Enter the name.

. Select the data type.

Enter the length and scale.

. To perform calculations on the output columns, perform one of the following:

+ If you know how to write the formula, enter the expression to perform calculation.
+  From the list, select the required elements, operator and functions.

Note:
For more information about functions, see Functions used in Expressions.

. Choose Add.

Applying Filter on Aggregation and Projection view Attributes (optional)

F

aoprODN-=

Right-click the required attribute.

rom the context menu, choose Apply Filter.

Select the required operator.
Enter value.
Choose OK.

Note:

You can edit a filter using filter expressions from the output pane that offers more conditions
to be used in the filter including AND, OR, and NOT. For example, to retrieve the sales of a
product where (revenue >= 100 AND region = India) OR (revenue >=50 AND region =
Germany).

Adding Attributes and Measures to Calculation View Output

a. F

eovo

If

a.

b

C.

d

rom the workflow pane, choose the Output node.

To add an attribute, from the context menu, choose Add as Attribute.
To add a measure, from the context menu, choose Add as Measure.

you want to create calculated attributes, perform the following substeps:
In the Output pane, right-click Calculated Attributes.

. From the context menu, choose New.

Enter a name and description.

. On the Key tab, define the formula for the calculated attribute as follows:
a. Select a data type for the calculated attribute from the dropdown list.
b. Enter the length and scale.

c. Select the required attributes, operator, and function.
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Note:
For more information about functions, see Functions used in Expressions.

d. To check the validity of the formula, choose Validate.
e. Choose Add.

e. To add a Description to the calculated attribute, write the formula as above.

e. If you want to create calculated measures, perform the following substeps:

a. In the Output pane, right-click Calculated Measures.

b. From the context menu, choose New.

a. Enter a name and description.

Select the required Aggregation Type.
If you want to hide the measure while previewing data, choose Hidden.
Select the required data type.
Enter the length and scale.
Define the measure by selecting the required measures, operator, and function.

S N

Note:
For more information about functions, see Functions used in Expressions.

g. Choose Validate.

Note:

If you want to associate the calculated measure with a unit of currency or weight, choose
the Currency/Unit of Measure tab page. For more information, see Using Currency
and Unit of Measure.

h. Choose OK.

Note:

If you set the calculation view property Multidimensional Reporting as disabled, you can create
a calculation view without adding any measure to the calculation view output. A calculation view
without any measure works like an attribute view and is not available for reporting purposes.

Creating Counters (optional)

To obtain the number of distinct values of an attribute, perform the following substeps:

1. In the Output pane, right-click Counters.
2. From the context menu, choose New.

3. Choose Add Attribute.

4. Choose OK.

1. You can choose to hide the attributes and measures that are not required for client consumption
by assigning value true to the property Hidden in the properties pane.

2. You can choose to create variables, and bind them to attributes for filtering data. The values
you provide to the variables at the runtime determines which data records are selected for
consumption. For more information, see Assigning Variables.

3. You can choose to create input parameters for the union, join, projection, aggregation and
calculation view output. For more information, see Creating an Input Parameter.
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Note:

4. You can choose to create hierarchy between attributes of the view. For more information, see
Creating a Hierarchy.

5. You can specify a value for the Default Client property of the view to filter the table data that
is relevant to a specific client as specified in the table fields, such as, MANDT or CLIENT, at
runtime. The default value for the property is the one that is specified as preferences. If the
property is set to Dynamic then at runtime, the value set for the Session Client property is
considered to filter table data. The Session Client property is set while creating a user. For
more information about how to set the default value for Default Client, see Setting Preferences
for Modeler.

Save and Activate

a. To save the calculation view, choose File > Save.
b. From the context menu of the Calculation View, choose Activate.

Note:
For more information about activation, see Activating Objects.

You can choose to generate documentation for the calculation view. For more information, see Generating
Object Documentation.

9.4.1 Managing Attribute Mappings

You use this procedure to map the source attribute to the target attribute if there is a big list of attributes,
or to assign a constant value to the target attribute.

Procedure

1. Right-click the attribute in the target list.
2. From the context menu, choose Manage Mappings.

a.
b.

To map the source to the target column, select the required source from the dropdown list.

To assign a default value to the constant column, enter the value in the Constant Value field.
For more information, see Constant Column.

Select the required data type.

. Enter the length and scale as required.

Choose OK.

9.4.2 Constant Column

In a union view, a Constant Column is created if there are any target or output attributes for which
there is no mapping to the source attributes. The default value for the constant column is NULL.
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Note:
The target attribute is mapped to all the sources.

For example, you have two tables with similar structures, Actual Sales and Planned Sales, corresponding
to the sales of products. You want to see the combined data in a single view, but differentiate between
the data from the two tables for comparisons. To do so, you can create a union view between the two
tables and have a constant column indicating constant values like A & P, as indicated below:

Actual Sales
Sales Product
5000 A1
2000 B1

Planned Sales

Sales Product
3000 A1
6000 B1

The result of this query can be as follows:

Actual Planned Indicator Sales Product
A 5000 A1
P 3000 A1
A 2000 B1
P 6000 B1

9.5 Creating an Analytic Privilege

You apply analytic privileges when business users access values with certain combinations of dimension
attributes. You can use analytic privileges to partition data among various users sharing the same data
foundation. You can assign analytic privileges in two ways:

- Privileges for Selected Content Models - to define restrictions for a selected group of models. For
example, you have defined a restriction on an attribute CUST_ID that belongs to the CUSTOMER
attribute view. The restriction is applicable to all the selected content models that use this attribute
view.
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Privileges for All Content Models - to define restrictions for all content models across multiple
packages that are specific to a user. For example, you have defined a restriction on an attribute
view CUSTOMER that belongs to the SALES package and the user EMP. The restriction is applicable
to all content models across multiple packages that use CUSTOMER and that are specific to EMP.

Note:

T

he restrictions that you set for attributes belonging for attribute views also apply to analytic views, if

the same attribute is reused. However, the restrictions set for attributes belonging to either analytic or
calculation views apply only to the analytic or calculation views, if the same attribute is reused.

Procedure
1. Set Parameters for the Analytic Privilege
1. In the Modeler perspective, expand the system node from the Navigator pane.
2. Expand the Content node.
3. Select the required package.
4. From the context menu, choose New > Analytic Privilege.
a. Enter the name and description of the analytic privilege.
b. Choose Next.
c. Select the required information models.
d. Choose Add.
e. Choose Finish.
Note:
You can choose to add more content models in the editor pane.
2. Add Attributes
1. If you want to add restrictions for all content models, select the Applicable to all Content Models
checkbox.
Note:
If you do not select this option, the restrictions you create apply only to the secured list of models.
2. Inthe Associated Attributes Restrictions pane, choose Add.
3. Select the attribute(s) for which you want to apply the restriction.
4. Choose OK.
Note:
If you do not add any attributes for restrictions then it means unrestricted access to the selected/all
content models, depending on the status of the check-box.
3. Assign Restrictions
1. In the Assign Restrictions pane, choose Add.
2. You can choose to change the value defined for Operator.
3. You can choose to enter a value or use the Value Help Dialog to search for a value.
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Note:
To activate the analytic privilege, you must assign a minimum of one restriction to each attribute.

4. Activate the Privilege

1. Choose File > Save.
2. From the context menu of the privilege, select one of the following options as appropriate:

» Activate - to activate the current view only.
+ Cascade Activate - to activate the current view and impacted objects.

Result

The administrator associates user with an analytic privilege. You can view the users and roles assigned
to the analytic privilege on the Users/Roles tab page.

9.6 Creating a Procedure

You use this procedure to create SQL procedures that can be reused by other content objects.

Note:
The catalog object that is generated on procedure activation is stored in the _SYS_BIC schema.

Prerequisites
You have repository authorization at the package level.

Procedure

1. On the Quick Launch tab page, choose Procedure.
2. Enter a name and description for the procedure.
3. For unqualified access in SQL, select the required schema from the Default Schema dropdown list.

Note:

If you do not select a default schema, while scripting you need to provide fully qualified names of
the catalog objects like <SchemaName>.<TableName>. If you do specify a default schema, and
write SQL script such as "select * from <TableName>", the specified default schema is used at
runtime to refer to the table.

4. Select the package in which you want to save the procedure.
5. Select the required option from the Run With drop-down list.

Note:
Definer's right. If you want to control access to the procedure for other users.

Invoker's right. If you want the system to grant access to the procedure for other users.

6. Select the required access mode as follows:
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Read Only Use this mode to create procedures for fetching table data.

Read Write Use this mode to create procedures for fetching and updating table data.

7. Select the language in which you are writing the procedure.

. Choose Finish.

9. In the function editor pane, write a script for the function using the following data types:
» Table or scalar data types for input parameters.
- Table data type for output parameters.

Note:

* You can only write one function in the function body. However, you can refer to other functions.
For more information about the syntax and examples of SQL functions, see SQL Functions on
Content Assist.

[2]

10. Choose File > Save.
11. From the context menu of the view, choose the appropriate option:
+ To activate only the current view, choose Activate.
+ To activate the current view and impacted objects, choose Cascade Activate.

Note:
For more information about activation, see Activating Objects.

9.7 Using Currency and Unit of Measure

You use this procedure to define a measure as an amount or weight in the analytical space and to
perform currency conversion.

To simplify the process of currency conversion, the system provides a list of currencies, and exchange
rates based on the tables imported for currency. Currency conversion is performed based on source
currency, target currency, exchange rate, and date of conversion. You can also select currency from
the attribute data used in the view.

Note:
Currency conversion is only enabled for analytic views.

For example, you need to generate a sales report for a region in a particular currency, and you have
sales data in database tables in a different currency. You can create an analytic view by selecting the
table column containing the sales data in this other currency as a measure, and perform currency
conversion. Once you activate the view, you can use it to generate reports.

Prerequisites
* You have imported tables T006 and TOO6A for Unit of Measure.
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* You have imported TCURC, TCURF, TCURN, TCURR, TCURT, TCURV, TCURW, and TCURX for
currency.

Procedure

1. In the Output pane, select a measure.

2. In the Properties pane, select Measure Type.

3. If you want to associate the measure with a currency, perform the following substeps:
a. In the Measure Type dropdown list, select the value Amount with Currency.
b. In the Currency Dialog, select the required Type as follows:

Type Purpose
Fixed To select currency from the currency table TCURC.
Attribute To select currency from one of the attributes used in the view.

c. Select the required value, and choose OK.
d. If you want to convert the value to another currency, choose Enable for Conversion.
a. To select the target currency, choose Currency.
Note:

In addition to the types Fixed and Attribute, you can select Input Parameter to provide the
currency at runtime.

b. Select the source currency.
c. Select the exchange type for exchange rates.
d. Select the date for conversion.

e. From the dropdown list, select the required value that is used populate data if the conversion

fails:
Option Result
Fail In data preview, the system displays an error for conversion failure.
Set to NULL In data preview, the value for the corresponding records is set to NULL.
Ignore In data preview, you view the unconverted value for the corresponding
records.

4. If you want to associate a measure with a unit of measure other than currency, perform the following
substeps:

a. Select the value Quantity with Unit of Measure in the Measure Type drop-down list.
b. In the Unit Dialog, select the required Type as follows:
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Type Purpose
Fixed To select a unit of measure from the unit tables T0O06 and TOO6A.
Attribute To select a unit of measure from one of the attributes used in the view.

c. Select the required value, and choose OK.
5. Choose OK.
Note:

You can associate Currency or Unit of Measure with a calculated measure, and perform currency
conversion for a calculated measure by editing it.

9.8 Assigning Variables

You use this procedure to assign variables to a filter at design time for obtaining data based on the
values you provide for the variable. At runtime, you can provide different values to the variable to view
the corresponding set of attribute data. You provide values to the variables either by entering the values
manually, or by selecting them from the Value Help dialog.

Note:
You can apply variables to attributes of analytic and calculation views.

The following types of variables are supported:

Type Description

Single Value Use this to filter and view data based on a single attribute value. For example, to
view the sales of a product where the month is equal to January.

Interval Use this to filter and view a specific set of data. For example, to view the expen-
diture of a company from March to April.

Range Use this to filter and view data based on the conditions that involve operators
such as "="(equal to), ">" (greater than), "<" (less than), ">=" (greater than or
equal to), and "<=" (less than or equal to). For example, to view the sales of all
products in a month where the quantity sold is >= 100..

Each type of variable can be either mandatory or non-mandatory. For a mandatory variable, you need
to provide a value at runtime. However, for a non-mandatory variable, if you have not specified a value
at runtime, you view unfiltered data.

Note:
You can check whether a variable is mandatory or not from the properties of the variable in the properties
pane.
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Procedure
1. Create a Variahle

1. In the Output pane, right-click the Variables node.
2. From the context menu, choose New and perform the following substeps:

a. Enter a name and description.
b. Select the required attribute from the drop-down list.

Note:
At runtime, the value for the variable is fetched from the selected attribute's data.

c. Choose the required Selection Type from the drop-down list.
d. Choose OK.

Note:
You can also choose to create a variable using the Create Variable option from the context menu of
an attribute. In this case, the details of variable is pre-filled.

2. Assign a Variable to a Filter

1. On the Logical View tab page, right-click the attribute.
2. From the context menu, choose Apply Filter.

3. From the Operator drop-down list, choose Variable.

4. From the Variable drop-down list, choose the required variable.
5. Choose OK.

Note:
You can also choose to create a variable and apply a filter using the Create Variable - Apply Filter
option from the context menu of an attribute.

9.9 Searching Related Tahles

While building models, you need to select tables for creating the master data, where, one table can
have multiple related tables. You use this procedure to search and add the associated tables for a table
in the data foundation.

Note:

System will suggest related tables from your schema only.
Prerequisites
You have imported DDOSL table in any one of the schemas.

Procedure
1. In the Data Foundation tab page, select the required table.
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From the context menu, choose Propose Tables.

From the drop-down list, select the table for which you want to find the related tables.
From the drop-down list, select the schema in which DDO8L metadata table is present.
To add related table(s) in Data Foundation tab page, perform the following steps:

a. Select the required table(s) from the list.

b. Choose OK.

Note:

If you want to build joins suggested by system between related tables, check the Automatically
Propose Joins checkbox.

akrobd

6. Choose OK.

9.10 Using System Generated Joins

While building models, you use number of tables and define relationship between them using joins.
You use this procedure to build joins suggested by the system for tables based on the metadata
information. In a business scenario where, tables have many columns and many associated tables,
system generated joins helps to define the relationship between the tables used.

Note:

+ The system will suggest join only if there is any relationship between the tables.
* You can edit the joins suggested by the system.

Prerequisites
You have imported DDOSL table in any one of the schemas.

Procedure
1. In the Data Foundation tab page, select the required tables.
2. From the context menu, choose Suggested Joins to create joins among tables.

Note:
You can overwrite the existing joins with the system generated joins.

9.11 Activating Objects

You activate objects available in your workspace to expose the objects for reporting and analysis. Based
on your requirements, you can:

+ Activate - To deploy the inactive objects.
- Redeploy - To deploy the active objects in one of the following scenarios:
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+ If your runtime object gets corrupted or deleted, and you want to create it again.
- If an object goes through client-level activation and server-level activation but fails at MDX, and
the object status is still active.

- Cascade Activate - To activate the inactive object along with the impacted objects. For example,
consider an analytic view AN1 being used in a calculation view C1. If you make changes to AN1,
and choose Cascade Activate, it activates C1 as well.

Depending on where you invoke the activation, redeployment or cascade activation, the behavior is as

follows:
Context Activate Redeploy Cascade Activate
Quick [A dialog box appears with a A dialog box appears with | Not Applicable
Launch | preselected list of all inactive a list of active objects in
tab objects in your workspace. your workspace.
page
Pack- |A dialog box appears with a A dialog box appears with [ Not Applicable
age preselected list of all inactive a list of active objects in
context [ objects in your workspace. your workspace.
menu
Con- [A dialog box appears with a Not Applicable Not Applicable
tent preselected list of all inactive
context | objects in your workspace.
menu
Editor |A dialog box appears with a A redeployment job is Not Applicable
preselected list of the selected |submitted for the selected
object along with all the depen- | object.
dent objects that are inactive in
your workspace.
Object [A dialog box appears with a A redeployment job is A dialog box appears with a
context | preselected list of the selected |submitted for the selected | preselected list of the inactive
menu | object along with all the depen- | object. object and impacted objects in
dent objects that are inactive in your workspace..
your workspace.
Note:

- If an object is the only inactive object in the workspace, the activation dialog box is skipped and the
activation job is submitted.
+ If an object is inactive and you want to revert back to the active version, from the editor or object
context menu, choose Revert To Active.

9.12 Creating an Input Parameter
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You use this procedure to allow you to provide input for the parameters within stored procedures, to
obtain a desired functionality when the procedure is executed. You use input parameters as placeholders
during currency conversion, input parameters of the script node, filter expressions, formulas like calculated
measures, and calculated attributes. The calculation of the formula is based on the input you provide
at runtime during data preview.

You can apply input parameters in analytic and calculation views. If a calculation view is created using
an analytic view with input parameters, those input parameters are also available in the calculation view
but you cannot edit them.

The following types of input parameters are supported:

Attribute Value Use this when the value of a parameter comes from an attribute.

Currency Use this when the value of a parameter is in a currency format, for example, to
specify the target currency during currency conversion.

Date Use this when the value of a parameter is in a date format, for example, to spec-
ify the date during currency conversion.

Static List Use this when the value of a parameter comes from a user-defined list of values.

Empty Use this when the value of a parameter could be anything of the selected data
type.

Each type of input parameter can be either mandatory or non-mandatory. For a mandatory input
parameter, it is necessary to provide a value at runtime. However, for a non-mandatory input parameter,
if you have not specified a value at runtime, the data for the column where the input parameter is used
is blank.

Note:

You can check whether an input parameter is mandatory or not from the properties of the input parameter
in the properties pane.

Example:

+ If you want to create a formula to analyze the annual sales of a product in various regions, you
can use Year and Region as input parameters.

- If you want to preview a sales report with data for various countries in their respective currency for
a particular date for correct currency conversion, you can use Currency and Date as input
parameters.

Procedure

1. In the Output pane, right-click the Input Parameters node.
2. From the context menu, choose New.

a. Enter a name and description.

b. Select the type of input parameter from the drop-down list.
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Note:

For the Attribute Value type of input parameter, you need to select the attribute from the
drop-down list. At runtime the value for the input parameter is fetched from the selected attribute's
data.

c. Select a data type.
d. Enter the length and scale for the input parameter.
e. Choose OK.

9.13 Creating a Hierarchy

You use this procedure to create hierarchies between attributes to enhance analysis by displaying
attributes according to their defined hierarchical relationships. Hierarchies can exist cross attributes
(that is, Country - State - City) or within the values of a single attribute (that is, Employee manager -
employee direct report).

You structure and define relationships between attributes in the attribute view and calculation view
using the following hierarchy types:

Level Hierarchy

A level hierarchy is rigid in nature, and the root and the child nodes can be accessed only in the
defined order.

Level hierarchies consist of one or more levels of aggregation. Members roll up into the next higher
level in a many-to-one relationship, and members at this higher level roll up into the next higher
level, and so on to the top level.

For example: an address hierarchy comprised of region, country, state, and so on.
Parent/Child Hierarchy

A parent/child hierarchy is a hierarchy in a standard view that contains a parent attribute. A parent
attribute describes a self-referencing relationship, or self-join, within the main table. Parent-child
hierarchies are constructed from a single parent attribute.

For example: a bill of materials hierarchy (parent and child) or an employee master (employee and
manager) hierarchy.

Procedure
Creating a Level Hierarchy

—

A WODN

. In the Output pane, right-click Hierarchy.

Choose New Level Hierarchy.
Enter a name and description for the hierarchy.
Add the required attributes from the drop-down list.
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6.

Note:
You can select attributes from the required table columns in the drop-down list to add to the view.

Select the required Level Type.

Note:
The level type is used to specify formatting instructions for the level attributes.

For example, a level of the type LEVEL_TYPE_TIME_MONTHS can indicate that the attributes of
the level should have a text format such as "January", and LEVEL_TYPE_REGULAR indicates that
a level does not require any special formatting.

Choose OK.

Creating a Parent/Child Hierarchy

1.

5.

In the Output pane, right-click Hierarchy.

2. Choose New Parent Child Hierarchy.
3.
4. If you have not specified the principal key attribute, select the Child Attribute from the drop-down

Enter a name and description for the hierarchy.

list.

Note:
Since you have not selected the principal key attribute while adding attributes, the selected child
attribute is added as the principal key attribute of the view.

Select the Parent Attribute from the dropdown list.

Note:

The hierarchies belonging to an attribute view are available in an analytic view that reuses the attribute
view, in read-only mode. However, the hierarchies belonging to an attribute view are not available in a
calculation view that reuses the attribute view.

9.14 Maintaining Search Attributes

You use this procedure to enable attribute search for an attribute used in a view. Various properties
related to attribute search are as follows:

Freestyle Search: Set to True if you want to enable the freestyle search for an attribute. You can
exclude attributes from freestyle search by setting the property to False.

Weights for Ranking: To influence the relevancy of items in the search results list, you can vary
the weighting of the attribute. You can assign a higher or lower weighting (range 0.0 to 1.0). The
higher the weighting of the attribute, the more influence it has in the calculation of the relevance of
an item. ltems with a higher relevance are located higher up the search results list. Default value:
0.0.

Note:
To use this setting the property Freestyle Search must be set to True.

Fuzziness Threshold: This parameter is reserved for future usage of Fault-tolerant search.
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Note:

It is recommended to use the default values for Ranking and Fuzziness at the beginning. You can tune
the search settings based on the experiences that you gained after some searches. Also collect the
feedback of your users and use it for fine-tuning.

9.15 Managing Data Foundation Layout

You use this procedure to adjust the data foundation and logical view layout comprising user interface
controls like, tables and attribute views in a more readable manner. This functionality is supported for
attribute views and analytic views.

The options available are as follows:

Option Purpose Suhbsteps
Auto Ar- | Use this option to arrange the user interface | |n the editor tool bar, choose =3 .
range elements automatically.
Show out- | Use this option to view an outline of the ele- | |n the editor tool bar, choose = .
line ments arranged so that , you do not have to
navigate in the editor using horizontal and
vertical scrollbars.
Highlight | Use this option if you want to view only those | 1 |n the editor, right-click the selected table.
related ta- | tables _that are related to a table selected in [, =01 the context menu, choose Highlight
bles the editor. related tables.
Display | Use this option if you have a table with a 1. In the editor, right-click the relevant table.

large number of columns in the editor, and
you want to view them in a way that meets
your needs: for example, only the table
name, or only joined columns, or the expand-
ed form with all the columns.

2. From the context menu, choose Display.

3. If you want to view only the table name,
choose Collapsed.

4. If you want to view all the columns of the
table, choose Expanded.

5. If you want to view only the joined
columns of the table, choose Joins only.

9.16 SQL Functions on Content Assist

This topic covers the functions that are supported using the content assist (ctrl + space) in the SQL
editor. You use this section to view the syntax and examples for the supported functions.
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Function Syntax Example
call + CALL - Internal Procedure Call Not Applicable
«  CALL Procedure Called From Client
*  CALL...WITH OVERVIEW From Client
case CASE Not Applicable
ce_aggre- | CE_AGGREGATION CE_AGGREGATION
gation
cecalc [. CE_CALC + CE_CALC usage in CE_PROJECTION
+ CE_CALC _VIEW + CE_CALC _VIEW
ce_col- |[CE_COLUMN_TABLE CE_COLUMN_TABLE
umn_ta-
ble
ce_con- [CE_CONVERSION CE_CONVERSION
version
ce_join |. CE_JOIN - CE_JOIN
+ CE_JOIN_VIEW + CE_JOIN_VIEW
ce_left out- [CE_LEFT_OUTER_JOIN CE_LEFT_OUTER_JOIN
er_join
e oep view | CE_OLAP_VIEW CE_OLAP_VIEW
ce_projec- | CE_PROJECTION CE_PROJECTION
tion
ce right out- | CE_RIGHT_OUTER_JOIN CE_RIGHT_OUTER_JOIN
er_join
ce_union al [ CE_UNION_ALL CE_UNION_ALL
ce_verti- |CE_VERTICAL_UNION CE_VERTICAL_UNION
cal_union
close CLOSE CURSOR Not Applicable
drop pro- [DROP PROCEDURE Not Applicable
cedure
drop type [ DROP TYPE Not Applicable
exec EXEC Dynamic Sql EXEC usage
explain EXPLAIN PLAN EXPLAIN PLAN usage
plan
export EXPORT as Binary Not Applicable
fetch FETCH CURSOR Not Applicable
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Function Syntax Example
for - FORLOOP - FOR LOOP Nested
*  FOR Looping over Resultsets *  FOR Looping over resultsets using Proce-
dure
if IF - IF for NULL
* IF for NULL check
import . IMPORT FROM Not Applicable
* IMPORT as Binary
open OPEN CURSOR Not Applicable
while WHILE LOOP WHILE LOOP nested loop
create + CREATE TYPE as TABLE + CREATE PROCEDURE - Implementing
+ CREATE PROCEDURE Read Only Pro- Functional Logic
cedure * CREATE PROCEDURE - Read only
Procedure
+ CREATE PROCEDURE with Cursor
»  CREATE PROCEDURE with IF as Control
Statement
+ CREATE PROCEDURE with Scalar
Variable
cursor CURSOR Not Applicable
Note:

For more information about the functions, see SAP HANA Database — SQLScript Guide.

9.17 Functions used in Expressions

This topic covers the functions that you can use while creating expressions like, calculated attributes
and calculated measures.

Conversion Functions
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Syntax

Example

int int int(arg) convert arg to int type int(2)
float float float(arg) convert arg to float type float(3.0)
dou- double double (arg) convert arg to double type double(3)
ble
sd- sdfloat sdfloat (arg) convert arg to sdfloat type
float
decfioat decfloat decfloat (arg) convert arg to decfloat type
fixed |fixed fixed (arg, int, int) arg2 and arg3 are the intDigits | fixed(3.2, 8, 2) + fixed(2.3, 8,
and fractdigits parameters, re- | 3)
spectively. Convert arg to a
fixed type of either 8, 12, or 16
byte length, depending on int-
Digits and fractDigits
string string string (arg) convert arg to string type
raw raw raw (arg) convert arg to raw type
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date

Syntax

Purpose
convert arg to date type. The

Example

time time(stringarg)
time time(fixedarg)
time time(int, int)

time time(int, int, int)

lar to date function above

date date(stringarg) : ! ..~ |date(2009) -> date('2009")
first version parses a string in
date date(fixedarg) the format "yyyy-mm-dd date(2009, 1, 2) -> date('2009-
o hh:mi:ss" where trailing compo- | 01-02")
date date(int, int) nents except for the year may
date date(int, int, int) be omitted. The version with | date(ixed(20000203135026.1234567,
P one fixed number arg strips | 10, 4)) -> date("2000-02-03
date date(int, int, int, int) digits behind the comma and | 13:50:26")
S tries to make a date from the
date date(int, int, int, int, int) | rest. The other versions accept
date date(int, int, int, int, int, the individual components to
. be set.
int)
long- . convert arg to longdate type,
longdate longdate(stringarg) |~ . . long-
date . similar to date function above. eteffxed{20000203135006.1234567,
longdate longdate(fixedarg) 10, 5)) -> longdate("2000-02-
longdate longdate(int, int, int) 03 13:50:26.1234500")
longdate longdate(int, int, int, longdate(2011, 3, 16, 9, 48,
PP 12, 1234567) -> long-
int, int)
date('2011-03-16
longdate longdate(int, int, int, 09:48:12.1234567")
int, int, int)
longdate longdate(int, int, int,
int, int, int, int)
time convert arg to time type, simi-

String Functions
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Function Syntax Purpose

strlen int strlen(string) returns the length of a string in bytes, as an integer
number.

midstr string midstr(string, int, int) returns a part of the string starting at arg2, arg3 bytes
long.
arg2 is counted from 1 (not 0)

leftstr string leftstr(string, int) returns arg2 bytes from the left of the arg1. If arg1
is shorter
than the value of arg2, the complete string will be
returned.

rightstr string rightstr(string, int) returns arg2 bytes from the right of the arg1. If arg1
is shorter
than the value of arg2, the complete string will be
returned.

instr int instr(string, string) returns the position of the first occurrence of the
second string
within the first string (>= 1) or 0, if the second string
is not
contained in the first.

hextoraw string hextoraw(string) convert a hexadecimal representation of bytes to a
string of
bytes. The hexadecimal string may contain 0-9, up-
per or lowercase a-f and no spaces between the two
digits of a byte; spaces between bytes are allowed.

rawtohex string rawtohex(string) convert a string of bytes to its hexadecimal represen-
tation.
The output will contain only 0-9 and (upper case) A-
F, no spaces and is twice as many bytes as the
original string.
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Function

Itrim

Syntax
string Itrim(string)

string Itrim(string, string)

Purpose

removes a whitespace prefix from a string. The
Whitespace characters may be specified in an option-
al argument. This functions operates on raw bytes
of the UTF8-string and has no knowledge of multi
byte codes (you may not specify multi byte whites-
pace characters).

rtrim

string rtrim(string)

string rtrim(string, string)

removes trailing whitespace from a string. The
Whitespace characters may be specified in an option-
al argument. This functions operates on raw bytes
of the UTF8-string and has no knowledge of multi
byte codes (you may not specify multi byte whites-
pace characters).

trim

string trim(string)

string trim(string, string)

removes whitespace from the beginning and end of
a string.

Ipad

string Ipad(string, int)
string Ipad(string, int, string)

add whitespace to the left of a string. A second string
argument specifies the whitespace which will be
added repeatedly until the string has reached the
intended length. If no second string argument is
specified, chr(32) (' ") will be added. This function
operated on UTF-8 bytes and has no knowledge of
unicode characters (neither for the whitespace string
nor for length computation).

rpad

string rpad(string, int)
string rpad(string, int, string)

add whitespace to the end of a string. A second
string argument specifies the whitespace which will
be added repeatedly until the string has reached the
intended length. If no second string argument is
specified, chr(32) (' ") will be added. This function
operated on UTF-8 bytes and has no knowledge of
unicode characters (neither for the whitespace string
nor for length computation).

replace

string replace(string, string, string)

replace every occurrence of arg2 in arg1 with arg3
and return the resulting string

Mathematical Functions
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tion Syntax

sign |int sign(double)
int sign(time)

int sign(date)

Sign returns -1, 0 or 1 depend-
ing on the sign of its argument.
Sign is implemented for all nu-
meric types, date and time.

abs double abs(double)
decfloat abs(decfloat)
decfloat abs(decfloat)

time abs(time)

Abs returns arg, if arg is posi-
tive or zero, -arg else. Abs is
implemented for all numeric
types and time.

double round(double, int)

round does rounding of abso-

round ; round(123.456, 0) = 123
lute values toward zer while
the sign is retained round(123.456, 1) = 123.5
round(-123.456, 1) = -123.5
round(123.456, -1) =120
round- double rounddown(double, int) round_dovs./nf.ro.unds L(_)ward rounddown(123.456, -1) = 120
down negative infinity making

rounddown(-1.1, 0) = -2

rounddown(-123.456, -1) = -
130

Date Functions

Function Syntax Purpose

utctolocal

utctolocal(datearg, timezonearg)

interprets datearg (a date, without timezone)
as utc and convert it to the timezone named
by timezonearg (a string)

localtoutc

localtoutc(datearg, timezonearg)

converts the local datetime datearg to the
timezone specified by the string timezonearg,
return as a date

weekday weekday(date)

returns the weekday as an integer in the
range 0..6, 0 is monday.

now now()

returns the current date and time (localtime
of the server timezone) as date
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Function

daysbe-
tween

Syntax

daysbetween(date1, date2)
daysbetween(daydate1, daydate?2)
daysbetween(seconddate1, seconddate2)

daysbetween(longdate1, longdate?2)

Purpose

returns the number of days (integer) between
date1 and date2. The first version is an alter-
native to date2 - date1.

Instead of rounding or checking for exactly
24 hours distance, this will truncate both date
values today precision and subtract the result-
ing day numbers, meaning that if arg2 is not
the calendar day following arg1, daysbe-
tween will return 1 regardless of the time
components of arg1 and arg2.

seconds-
between

secondsbetween(seconddate1, seconddate?)

secondsbetween(longdate1, longdate2)

returns the number of seconds the first to the
second arg, as a fixed point number. The
returned value is positive if the first argument
is less than the second. The return values
are fixed18.0 in both cases (note that it may
prove more useful to use fixed11.7 in case
of longdate arguments).

compo-
nent

component(date, int)

the int argument may be int the range 1..6,
the values mean year, day, month, hour,
minute, second, respectively. If a component
is not set in the date, the component function
will return a default value, 1 for the month or
the day, 0 for other components. The compo-
nent function may also be applied to longdate
and time types.

addsec-
onds

addseconds(date, int)
addseconds(seconddate, decfloat)

addseconds(longdate, decfloat)

Return a date plus a number of seconds.
Fractional seconds will also be used in case
of longdate. Null handling is (in opposition to
the default done with adds) to return null if
any argument is null.

adddays

adddays(date, int)
adddays(daydate, int)
adddays(seconddate, int)
adddays(longdate, int)

Return a date plus a number of days. Null
handling is (in opposition to the default done
with adds) to return null if any argument is
null.

Misc Functions
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if

Syntax

if(intarg, arg2, arg3)

return arg?2 if intarg is considered true
(not equal to zero), else return arg3.
Currently, no shortcut evaluation is
implemented, meaning that both arg2
and arg3 are evaluated in any case.
This means you cannot use if to avoid
a divide by zero error which has the
side effect of terminating expression
evaluation when it occurs.

Example

i NETWR"<=500000,A,
it NETVWWR'<=1000000B/C)
)

in(arg1, ...)

return 1 (= true) ifarg1 is equal to any
of the remaining args, return 0 else

case

case(arg1, default) case(arg1,
cmp1, value1, cmp2, value2,
..., default)

return value1 if arg1 == cmp1, value2
if arg1 == cmp2 etc, default if there
no match

case("CATEGORY",
IAI7 ILVI’ |Bl’ IMVI’
IHVI)

isnull

isnull(arg1)

return 1 (= true), if arg1 is set to null
and null checking is on during Evalu-
ator run (EVALUATOR_MAY_RE-
TURN_NULL)
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Processing Content Objects

10.1 Previewing Data of Content Objects

You use this procedure to preview the content of content models for analysis purposes.

Procedure

1. In the Modeler perspective, expand the Content node of the required system.
2. Select the object from a package for which you want to view the content.
3. From the context menu, choose Data Preview.

System displays the content in different formats as mentioned in the table below.

Raw Data All attributes along with data in a table format.
Distinct values All attributes along with data in a graphical format.
Analysis All attributes and measures in a graphical format.

4. Navigate to the required tab page and view the content.

10.2 Validating Models

You use this procedure to check if there are any errors in an information object and if the object is based
on the rules that you specified as part of preferences. For example, the "Check join: SQL" rule checks
that the join is correctly formed.

For more information about setting preferences, see Setting Preferences for Modeler .

Procedure

1. On the Quick Launch page, choose Validate.

. From the Available list, select the required models that system must validate.
. Choose Add.

. Choose Validate.

HOWOWDN
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10.3 Comparing Versions of Content Ohjects

You use this procedure to compare the active version of an information obejct with its inactive version.

Procedure

In the Modeler perspective, expand the Content node of the required system.
Select the required object from a package.

From the context menu, choose Open.

In the editor pane, choose Show Active Version.

Compare the inactive and active versions of the object.

Choose OK.

oakrubh-=

10.4 Viewing Version History of Content Objects

You use this procedure to view the version details of an information model for tracking purposes.

Procedure

1. In the Modeler perspective, expand the Content node of the required system.
2. Select the required object from a package.
3. From the context menu, choose History.

10.5 Switching Ownership of Inactive Objects

You use this procedure to take over the ownership of the inactive version of an object from other users'
workspace.

Objects in edit mode in other workspaces are not available for modification. In order to modify such
objects you need to own the inactive object.

The options available for changing the inactive object ownership are as follows:
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Switch Ownership

To take over multiple inactive objects from other users. Inactive objects that do
not have an active version are also available for take over using this option

Take Over

To take a single inactive object from other workspace that you wish to edit using
editor.

Note:

Using this functionality you can only own the inactive version of the object. The active version is owned
by the user who created and activated the object.

Prerequisite

You have obtained the Work in Foreign Workspace authorization.

Procedure

1. If you want to own multiple inactive objects from other workspaces, perform the following substeps:
a. In the Quick Launch tab page, choose Switch Ownership.
b. In the Source User field, select the user who owns the inactive objects.
c. Add the required inactive objects to the Selected Models section.

d. Choose OK.

2. If an object opens in read-only mode and want to edit it, perform the following substeps:

a. In the editor toolbar, select Switch Version.
b. Choose Take Over.

You can choose to save the changes made by the other user (owning the inactive version earlier)
to the inactive version of the object.

10.6 Generating Object Documentation

You use this procedure to capture the details of an information model or a package into a single
document. This helps you in viewing the necessary details from the document, instead of referring to
multiple tables. The following table specifies the details that you can view from the document.
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Type Description

Attribute View General object properties, attributes, calculated attributes, data foundation joins,
cross references, and where-used

Analytic View General object properties, private attributes, calculated attributes, attribute views,
measures, calculated measures, restricted measures, variables, input parameters,
data foundation joins, logical view joins, cross references, and where-used

Calculation View | General object properties, attributes, calculated attributes, measures, calculated
measures, counters, variables, input parameters, calculation view SQL script,
cross references, and where-used

Package Sub-packages, general package properties, and list of content objects

1. From the Quick Launch page, choose Auto Documentation.
2. In the Select Content Type field, select one of the following options as required:

Model Details To generate documentation for models such as attribute, analytic, and calcu-
lation views.
Model List To generate documentation for packages.

3. Add the required objects to the Target list.
4. Browse the location where you want to save the file.
5. Choose Finish.

10.7 Enabling Multilanguage Support for Objects

You use this procedure to enable translation of text pertaining to objects and their elements that did
not have Multilanguage support.

For example, you can enable Multilanguage support for models along with their elements like attributes
and measures in different languages.

Procedure

1. From the Quick Launch tab page, choose Migrate.
2. Select the required objects.

3. Choose Add.

4. Choose OK.
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Result

Object texts along with the corresponding elements are flagged for translation. These objects can be
viewed in multiple languages provided that the object texts are translated.

10.8 Checking Model References

You use this procedure to identify whether an information model is referenced by any other information
model(s).

Procedure

In the Modeler perspective, expand the system node in the Navigator pane.
Expand the Content node.

Expand the required package node.

Select the required object.

From the context menu, choose Where Used.

aprobd-=

10.9 Viewing the Jobh Loy

The job log displays information related to requests entered for a job. Job log comprises of two tab
pages as follows:

+ Current: Lists all waiting, running, and last five jobs.

+ History: Lists all the jobs.

Note:
You can terminate the job only if it is in the waiting state.

You can perform the following operations using the job log:
»  Open Job Details: You use this to view the job summary in the current tab page.

»  Open Job Log File: You use this to view the information pertaining to a job in detail using the internal
browser.

» Clear Log Viewer: You use this to delete all the job from the current tab page.

+  Export Log File: You use this to export the log file to a target location other than the default location
for further reference.

+ Delete Job: You use this to delete single job from the current tab page.
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Exporting Objects

11.1 Creating a Delivery Unit

You use this procedure to create a delivery unit, which is a group of transportable objects for content
delivery. For example, to transport the design time objects that are stored in the SAP HANA database
repository to other SAP HANA database installations.

Note:
A delivery unit is identified by a vendor and a name.

Prerequisite

You have ensured that the vendor property has been set. For more information about how to set the
vendor property, see Setting Preferences for Modeler.

Procedure

1. On the Quick Launch page, choose Delivery Units.
2. Choose Create.
3. Enter the details as follows:

Field Name Value

Name Name of the delivery unit.
Responsible Name of the responsible user.
Version (optional) Version of the delivery unit as defined by the responsible user.

Support Package Version (optional) | Support Package level of the delivery unit.

Patch Version (optional) Patch level of the delivery unit.
Note:
The version information of a delivery unit is helpful for shipment use cases like, from SAP to customer.
4. Choose OK.

o

In the Assigned Packages section, add the required packages that you want to export.
6. Choose Close.
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11.2 Exporting Objects using Delivery Unit

You use this procedure to export all packages that comprises a delivery unit and the relevant objects
contained in the packages, to the client or to the SAP HANA server file system. The exported objects
are available for import in the form of .tgz file at the specified location. Users who want to reuse these
objects can import the related file.

Prerequisite
You have created a delivery unit. More information: Creating a Delivery Unit.

Procedure

In the File menu, choose Export.

Expand the SAP HANA content node.

Select Delivery Unit.

Choose Next.

Select the system from where you want to export the models, and choose Next.

Note:
If you choose to export objects using Export option on the Quick Launch tab page, you do not
have to select the source system as your current system is considered as the source.

aRrwbdb-=

6. Select the delivery unit.

7. If you want to export the packages that are created or modified during a time range, select the Filter
by time checkbox.

8. Select the export location as one of the following:
»  Toexport objects on server to a specific file directory specified by an administrator, select Export
To Server.
+  To export objects to a client file system, select Export to Client.

9. Choose Next.
10. Choose Finish.

11.3 Exporting Objects using Developer Node

You use this procedure to export individual objects to a directory on your client computer. For example,
developers working on content creation can use this mode to share objects in a collaborative development
environment.

Note:
This mode of export should only be used in exceptional cases since this does not cover all aspects of
an object like, the translatable texts are not copied.
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Procedure

1.

[=2]

In the File menu, choose Export.

2. Expand the SAP HANA content node.
3.
4. Select the system from where you want to export the objects, and choose Next.

Select Developer Mode, and choose Next.

Note:
If you choose to export objects using Export option on the Quick Launch tab page, your current
system is considered as the source.

Add the required objects that you want to export.

. Browse the target folder where you want to export the objects.
. Choose Finish.

Selected objects along with the properties file are stored in a package at the specified location under
a <System ID> package. Properties file gets created with the same name as the package in the
format <PackageName.properties>.

11.4 Exporting Objects using SAP Support Mode

You use this procedure to export an object, along with other associated objects and data, and provide
them to the SAP support. You should use this mode only when you report an issue to the SAP Support
and you receive a request to export the specific objects along with the associated objects and data to
reproduce the issue.

Procedure

apRrwbd-=

In the File menu, choose Export.

Expand the SAP HANA content node.

Select SAP Support Mode.

Choose Next.

Select the system from where you want to export the models, and choose Next.

Note:
If you choose to export objects using Export option on the Quick Launch tab page, your current
system is considered as the source.

. Select an object that you want to export along with all the relevant details for SAP support purpose.
. Choose Finish.
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Importing Objects

12.1 Importing Objects using Delivery Unit

You use this procedure to import objects, which are grouped into a delivery unit, in the form of .tgz file
from the server or client location to a target system.

For example, customers can use this option to bring repository content from one system to another

Procedure

1.

In the File menu, choose Import.

2. Expand the SAP HANA content node.
3.
4. Select the target system where you want to import the models, and choose Next.

Choose Delivery Unit, and choose Next.

Note:
If you choose to import objects using Import option on the Quick Launch tab page, your current
system is considered as the target.

Select the required file from the server or client.

. Select the following options as required:

Overwrite inactive | To replace inactive objects in the target system with the inactive objects of
versions the selected file.

Activate objects To activate objects of the selected file in the target system.

. Choose Finish.

12.2 Importing Objects using Developer Node

You use this procedure to import objects from a client location to your SAP HANA modeling environment.

Procedure

1.

In the File menu, choose Import.
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[

Expand the SAP HANA content node.
Choose Developer Mode, and choose Next.
Select the target system where you want to import the objects, and choose Next.

Note:
If you choose to import objects using Import option on the Quick Launch tab page, your current
system is considered as the target.

Browse the required source folder from where you want to import the objects.

Note:
Select the source <System ID> folder that contains the folder with the required objects. For example,
to import objects of package P1 exported from system A1, select the folder A1 and not P1.

Select the required objects.

If you want to replace the existing objects in the target system with the selected objects, select
Overwrite Existing Objects checkbox.

Choose Finish.

The selected objects get imported as following:

+ If at the target, a package with the same name as the one to be imported exists, however, the
package languages differ, objects get imported with a warning message.

- If at the target, a package with the same name as the one to be imported does not exist, then
the respective package with its original language (fetched from the properties file) is created.

» In case of old objects for which properties file does not exist, a package with its language set to
the logon language gets created.
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